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1 Introduction

In this lab we’ll work through making a model of an object, or at least get
started on it. The object we’ll be working with is the University clocktower.
This is a fairly complex building, so we’ll simplify things a bit. Firstly, we’ll
just do the clocktower itself, not the whole building, and secondly we’ll ignore
a lot of the fine detail. This lab is a walkthrough of one way to do this, but
should hopefully give you some experience with Blender and an idea of how
things work. Also, feel free to mix things up a bit as you go – add a bit of detail
here, or adjust some dimensions there.

To get started it is often useful to get some reference images and make a
sketch of the object. In many cases it is a good to do this sketch on graph
paper, so that you can judge how big things need to be. Here’s what I did to
get started:

Note that the sketch doesn’t have all the details in it, but it has more than
enough for our purposes. I’ve also identified five main components, which will
help us to structure the model a bit.
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2 Getting Started with Blender

When you open up Blender it should look something like this:

There are several main parts to the screen:

1. The main 3D View, where you will be doing most of the designing.

2. The Outline View which shows the structure of the scene.

3. The Properties panels which contain a lot of detailed settings.

4. An Animation View, which won’t be used in this tutorial.

The default scene has three objects in it – a cube, a camera, and a lamp.
To start with we can render the default scene – just choose Render Image from
the Render menu. The image is drawn, but is not saved – if you want to do
that you can choose Save Image from the Image menu at the bottom of the 3D
view. Press esc to get rid of the rendered image.

There are a few things to keep in mind when using Blender:

• If you are part way through an operation and want to cancel it, pressing
esc usually often it.

• Blender uses its own key bindings, rather than operating system-specific
ones. In particular, control-z is undo even on OS X where it would
normally be command-z.

• Blender key commands are case sensitive, so a selects all, while A adds a
new object. Modifier keys like shift or alt will be written in lower case
to match the keyboards in the lab.

• You can rotate the view by holding down the middle mouse button (or
wheel).
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• To slide the view around, hold down shift while dragging with the middle
mouse button.

• The middle mouse button zooms the view in and out.

• To delete an object, select it and press x.

3 Some Basic Shapes

We’ll start by using some basic shapes (or primitive objects) to make the general
shape of the tower. By the time you’ve finished this section your model should
look something like this:

3.1 The Main Tower

That starting cube looks like a good place to get started with our model – it
could do quite well for the main tower component. Select just the cube, by
right-clicking on it – the cube should be highlighted in orange, while the camera
and lamp are dark. You can deselect things by holding down shift while right-
clicking, and (de)select everything by pressing a. However, we want to make it
taller. To do this we need to stretch it a bit, and there’s a lot of ways to do
that – we’ll look at 3.

3.1.1 Mouse-based Manipulation

The first approach is to use the mouse and the co-ordinate axes attached to the
cube. There are three axes – the X-axis is red, the Y-axis green, and Z is blue.
If you click on one of those arrows and drag it the cube will move along that
axis. You can change this behaviour in a panel at the bottom of the screen that
looks like this:
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There are three options here:

• The arrow is translation – moving the object around.

• The curve is rotation – spinning the cube in place.

• The line with a box at the end is scaling – the one we want.

Switch to scaling and stretch the cube vertically a bit. If you get in a bad
place, then control-z will undo your changes.

3.1.2 Keyboard Manipulation

An alternative is to use shortcut keys. Just about every key in Blender is
a shortcut, so be prepared for unexpected weirdness if you are mashing the
keyboard while using it!

The shortcut for scaling is s – press it while the cube is selected then you
can make the whole block bigger or smaller by moving the mouse. Click the left
button to fix the scale where you’ve put it (or press return or enter). Press
esc to cancel the operation if it’s going a bit wrong.

Often we want to scale just in one direction, like we could with the mouse-
based approach. To do that press s then the axis you want to scale along (x, y,
or z). Then move the mouse as before.

Finally we can scale by precise quantities by pressing s, then (optionally) an
axis, then a number. So to scale by a factor of 2 along the Z axis you’d type s

z 2 enter.
You can do the same with translation and rotation. The keyboard shortcut

for translation is g (for ‘go to’), while rotation is r.

3.1.3 Entering Values Directly

Looking at our plan, we want the main tower to be 4 units wide, and 20 units
tall. Getting this precisely with the mouse is very difficult, and deciding on the
chain of things to do with the keyboard is not always easy. An alternative is
just to say how big we want the object to be.

To do this we first need a new bit of the Blender interface – by pressing n

you can bring up a pane with lots of numbers describing the currently selected
object. At the top we have Location, Rotation, Scale, and Dimensions. Since
we want the main tower to be 4 × 4 × 20, we can just enter 4, 4, and 20 in the
X, Y, and Z Dimensions.

We can also think about where we want the tower to be. There’s a grid
displayed through the X-Y plane, and it is convenient to think about that as
the ground, so we want the tower to sit on that plane. Since the tower is 20
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units tall, this means it should be centred 10 units above the ground. Set the
cube’s location to be 0, 0, 10.

Save your work now. Press control-s, or select Save from the File menu.
This is always important, and newer version of Blender are pretty stable, but
do it now. Do it often. Save partial models with different names as backups. If
you’re wondering what to do next, press control-s.

3.2 The Clock

The second part of the tower includes the clock, but the basic shape is still
roughly a cube. We could extend the main tower further up, but things will be
easier to organise if we keep it separate. To do this we need to add a new cube –
in the 3D View press A to bring up the Add menu, then select Mesh then Cube.
Adjust the new cube so that it is 4× 4× 5 units in size and centered 22.5 units
above the ground plane.

3.2.1 Naming Things

If you look in the Outline View in the top right, you’ll see that the objects we’ve
got now are Cube and Cube.001. This is not very helpful, especially when you
end up with Cube.623 etc. To help manage things it is a good idea to name
your objects sensibly. You can change the name of an object by double-clicking
on it in the Outline View (note that a single left-click will select the object).
Rename the two cubes to MainTower and ClockTower, or something similarly
descriptive.

3.3 The Roof

The roof is roughly a pyramid, but we can get there from a cube. Basically the
idea is that we start with a cube, put in a few divisions for the middle tier of the
roof, and then collapse the top corners together to make a point. We want to
start with another cube the same size as the ClockTower. We could add a new
cube, as before, but it is easier just to make a copy. Select the ClockTower cube
and press D. Rename the new cube to Roof and position it above the ClockTower.

3.3.1 Edit Mode

Next, lets get this cube looking less square at the top. To do this we need to
switch mode in Blender – so far we have been in Object Mode, since we’ve been
dealing with whole objects, but we need to change to Edit Mode. First select
the Roof, then either choose ‘Edit Mode’ from the menu at the bottom of the
3D View, or press tab. We now have a view of the object which shows the edges
and corners (vertices) and can select or deselect individual vertices.

Right-click on one of the top vertices then hold down shift and right-click
on the other 3. In the Tools tab on the left open the Merge drop-down and
choose At Center. You can also open this menu in the editor by pressing alt-m.
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Go back to Object Mode by choosing it from the menu or pressing tab
Save your work now.

3.4 The Turrets

Next we have the four small turrets. We’ll start with making one, then copy
it to make four identical ones. The nearest primitive object to the turrets is a
cylinder, which you can add in the same way as a cube. Make a cylinder called
Turret that is 7 units high, and 1 unit wide and deep. Place it so that it is
centred at 2, 2, 23.5.

Now we need to make it pointed at the top and bottom, so go into edit
mode. Notice that the cylinder only has vertices around the top and bottom
faces, so if we merge those at the centre we’ll end up with the cylinder vanishing
to a line. First we have to add some more vertices to divide the cylinder up.
There’s a useful tool for this in the panel on the left, called Loop Cut and Slide.
Select that then move the mouse over the Turret. You should see a magenta
circle around the middle of the turret. Left click and you can start to slide that
circle up and down the cylinder.

Watch the numbers in the top of the numeric panel to the left as you move
up and down – the Z value should change from −1 at the bottom of the cylinder
to +1 at the top. These are local co-ordinates, which are measured relative to
the cylinder. You can switch these to global co-ordinates, which are measured
relative to the world. When you’ve got the new points where you want them
you can lock them down by left-clicking. You can then update their positions
using the global or local co-ordinates.

Put two new rings of points around the cylinder, one two units up from the
base (Z = 22 in global co-ordinates, or about −0.43 local), and one two units
down from the top (Z = 25 global or +0.43 local).

Now that we have a bit more structure, we can merge the top and bottom
rings of vertices together. Instead of selecting each one individually, you can
select by drawing a box on the screen. Get into a view where you can see the top
or bottom of the cylinder clearly, press b, then left-click and drag to draw a box
around the points with the mouse. Go ahead and merge the top and bottom
vertices together to create a spindle shape with points at each end. Then go
back to object mode.
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Note that some of the vertices at the bottom of the turret are inside the
main tower, which can make them hard to select. There are a few ways to get
around this. One is to move the turret aside while we work on it, another is
to use layers, which we’ll get to later. For now we can see all the vertices by
changing from the solid view we have now to a wireframe view. To do this, open
the menu just to the right of the Edit/Object mode menu at the bottom of the
3D view. There are a lot of different view types here, but just select Wireframe
for now.

Save your work now. I’m not going to keep adding this, but hopefully
you’ve got the message. . .

3.4.1 Smooth Shading

The turret’s shape should look OK, but if you go back to the Solid view and
look closely you’ll notice that you can see that the cylinder is made up of narrow
strips. You can reduce this problem by having Blender smooth out the shading
across the faces. Simply select the object then choose Smooth under Shading in
the panel on the left.
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Now that we have one good-looking turret, we can duplicate it with D, and
make four copies, placing them around the top of the tower.

3.5 The Buttresses

The tower’s base is supported by 8 buttresses. As with the turrets we’ll make
one then duplicate it. Follow these steps to make a buttress:

1. Add a new cube and call it Buttress.

2. Make it 8 units high and 1 unit wide and deep.

3. Place it at 2.5, 1.5, 4.

4. Go into edit mode.
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5. Add loop cuts at heights of 1, 3, 4, and 7 units in global co-ordinates
(-0.75, -0.25, 0, and 0.75 local).

6. Select the vertex at the top of the buttress that is against the edge of the
tower.

7. Hold down shift and select the vertex that is connected to the first, but
not against the tower.

8. Merge these vertices, but choose At First rather than At Center.

9. Repeat this for the other pair of vertices on the top of the buttress.

10. Select the next four vertices down the face at the front of the buttress.

11. Change their X value from 3.0 to 2.5 (global) or 1.0 to 0.0 (local).

Leave edit mode and make 7 additional copies of this buttress around the
building. You will need to rotate them around the Z-axis to get them to line
up. You can do this numerically, with the mouse, or with keys as described for
scaling at the start of this tutorial.

4 Setting the Scene

Now that we’ve made a good start on the tower, we can render a scene. Select
Render Image from the Render menu, or press F12. The image you see should
look something like this:
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4.1 Placing the Camera

This is a picture of the tower, but there are a few problems. The big one is
that we’re looking at it from the wrong place and and wrong angle. Press esc

and make sure you are in object mode. Select the camera, either by clicking
on its wire-frame in the 3D view, or choosing it from the outline view. If you
can’t find the camera, select on Camera in the outline view then press . on the
number pad. This will centre your view on the selected object.

For now we want to see what the camera sees. We can do this by pressing 0

on the numeric key pad, or selecting Camera from the View menu at the bottom
of the screen. Your 3D view should show a box which is the camera’s view, and
everything outside the box is darker.

Now we can change the camera position and properties, and see what effect
this has on the view of the camera. Firstly, we want to make a picture of a
tall building, so a wide landscape view is not the best. We can either rotate
the camera around, or just change the shape of the picture. The second option
is easier since it makes the 3D rotations a bit simpler to manage later on. In
the Properties Panel on the right there are a lot of different panels that can be
brought up by clicking on these icons:

By default the Scene Properties (the camera icon) are selected, but if not,
click on the camera icon. In the Dimensions property group there is a Resolution
which by default is 1080×1920. Edit these numbers so that they are 1920×1080.
The camera’s view should now be taller than it is wide.
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We are too close to the tower to see it all, so we need to move the camera
back. The Location of the camera in the numeric properties is roughly 7.48,
-6.51, 5.34. Lets step back twice as far in X and Y , changing the X location to
15 and the Y location to -13.

This looks more promising, but we need to rotate the camera so that it looks
up. 3D rotations are tricky – we’ll talk about them in lectures fairly soon – but
for now we can do a bit of trial and error. Try changing the X, Y , and Z angles
a little bit and see how the camera view changes. Increasing X seems to help,
so do that until the base of the tower is near the bottom of the camera’s view.

We still can’t see the whole tower, so move back further and experiment
with the camera’s position and orientation until you’re happy with the view. If
you get stuck, then putting the camera at 27.5, -24, 5 with rotation angles of
105, 0, and 50 is not terrible. Rendering an image will now produce something
like this:
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Have you saved your work recently?

4.2 Lighting

We’ve now got a good view of the tower, but the lighting isn’t really showing it
off. Lighting is a big topic from both a technical and artistic perspective, and
we’ll discuss it more later in the course. For now we’ll start by removing the
existing light – select it in either the outline or 3D view, and press x in the 3D
view to delete it.

4.2.1 Turn on the Sun

We’ll now add a new light. Press A and open the Lamp sub-menu. There are
five options here – Point, Spot, Sun, Hemi, and Area. The light we just deleted
was a Point light source, these are like a bare light bulb in a room and cast light
in all directions that dies off with distance. A Spot light source is like a point
light source, but it casts light in only some directions. A Sun provides constant
light from one direction, which is a good approximation to a very distant, very
bright light source (like the Sun). A Hemi is like a Sun, but only illuminates
in front of the light’s position, and an Area light source simulates a glowing
surface.

Add a Sun to the scene – since it is a directional light source, it doesn’t really
matter where you put it. What matters is what direction it is facing, which is
indicated by the dashed line extending from the light source. You can see the
effects of this direction by having Blender render the scene as you change it.
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We’ve already seen Solid and Wireframe views, but now we want to change
to Rendered. This doesn’t display the light or camera, but does show the objects
more-or-less as they’ll be drawn (it’s a quick preview, so not always accurate). If
the new Sun is not selected, switch back to Solid view to select it before changing
to Rendered. The rendered view can be slow, but is useful for checking lighting
and textures. With the default light angle being straight down the model looks
something like this:

If we rotate the light by 60 degrees in Y we get a better effect:

4.2.2 Ambient Light

With just a single Sun light source, the shadowed side of the tower is completely
black. For an object floating in space this is fairly accurate, but the scattering of
light off other objects and through the atmosphere means that this is not what
usually happens on Earth. We could add more light sources, or some other
objects and do complex computations, but an easier way is to approximate this
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by some sort of overall base lighting, which is commonly called ambient light
or, in Blender, environment lighting.

In the Properties panel select the fourth icon across, which looks like a little
globe. This brings up the World properties. Turn on Environment Lighting,
and set its Energy to about 0.3. If you render the image now it should look like
this:

4.3 Background

The tower is looking OK now, but it is floating in space, which is a bit weird. A
simple background would just be some flat ground for the tower to sit on. Add
a new Plane, call it Ground, place it at 0,0,0, and resize it so that it is very big
(say 1000 units on a side).
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This looks better, but shouldn’t the tower be casting a shadow? Select the
Sun light source, and go into the Data properties panel, which for this object
has a little sun-shaped icon. Down the bottom there is a panel called Shadow
which is currently set to No Shadow. Changing this to Ray Shadow will give us
the shadows you’d expect. While we’re here, change the sun’s Energy to 0.7 so
that the sum of the sunlight (0.7) and ambient light (0.3) is 1.

5 Managing the Scene

We are going to start adding some more detail to the model, but first its worth
thinking about how we can organise things. Even with this simple model we
have 17 objects, a light, and a camera. These start to get in the way of each
other – working on the main tower might be easier if the buttresses weren’t
there for example.
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5.1 Working with Layers

Part of Blender’s solution to this is to use layers which can be displayed or
hidden as needed. These are shown at the bottom of the 3D View with the
layers with objects in them having a little orange dot, and active layers shaded
a bit darker.

What constitutes a layer depends a lot on the scene. In a model of a city, the
clock tower might be a layer, or all of the buildings perhaps. Since we’re just
modelling a single building, however, we can afford to use a finer division. The
original plan for the clock tower identified 5 main components – the main tower,
the clock, the roof, the turrets, and the buttresses. Lets make each of those a
layer, and keep an extra one for general scene stuff like the camera, lights, etc.

We’ll start with the main tower. Select the MainTower object in the 3D
view, press m, and then select the layer you want to move it to. Move it to the
second layer, and it vanishes. You should now be able to switch between the
layers, or to turn multiple layers on or off by holding down shift while clicking
on them.

Move the other main components to their own layers. As a shortcut you can
press a number after m, with 1 being the first layer, 2 the second, and so forth.

5.2 Parents and Children

The other sort of organisation that would be useful is treating objects as a
group. For example, suppose we wanted to make the buttresses a bit taller.
We’d have to edit 8 individual objects to do so.

We can start by linking the objects together in the tree provided by the
Outliner. This is a form of a scene graph, which we’ll come back to later in the
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course. Grab the mesh icon (the orange triangle) beside Turret.001, and drag
it over Turret. A message saying ‘Drop to set parent’ should show up, so let it
go. If you open up the Turret object by clicking on the small + to its right you
can see that Turret.001 is now a child of it in the tree. Repeat this for the other
two turrets.

Another way to make these parent relations is with the keyboard. In the 3D
view select the object you want to be the child and then the parent (order is
important here). Press control-p and select Object from the pop-up menu.

Now try moving Turret – all the others should move with it (be sure to put
it back by pressing esc before you finish the move or control-z afterwards).
Note that you can still move the other turrets independently, if you want to
change their location relative to the base object.

Make all the other buttresses children of Buttress. Your scene should now
have a small number of top-level objects, most of which correspond to layers.

5.3 A Little More Detail

Now that we have some more structure, lets add just a bit more detail to the
scene. Select just the layer with the ClockTower object in it.

This doesn’t look much like a clock – there’s no clock face to start with. A
clock face is a circle, but we want the face to be set in to the tower a little.
We’ll start by removing some cylindrical holes through the cube that’s already
there, then add the clock faces.

We want to cut a cylinder out from the cube, so first make a cylinder. You
want this to be 2.5 units wide and deep, and more than 4 units tall so that it
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is longer than the cube is thick. Rotate the cylinder by 90 degrees about the
X axis, give it smooth shading, and place it so that it is centred in the same
location as the ClockTower object. This object will get a generic name like
Cylinder – we’re not going to keep it around for long so this is OK, but you
might want to call it something more meaningful to get into the habit.

Now we want to do something new – subtract the cylinder from the cube.
Select the ClockTower cube and open the Modifiers Properties panel, which is
the one with the spanner option. Choose Add Modifier and select Boolean, which
is near the top of the Generate column. Select Difference from the Operation
drop-down, and in Object select the cylinder you just made. Click on Apply.

Nothing seems to have happened? Try moving the cylinder away from the
ClockTower – there’s a hole through the middle of it now.
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Change the rotation of the cylinder to be 90 degrees around the Y axis
(rather than X), and cut another hole through the ClockTower at right angles
to the first. You can now delete the cylinder, since we’re done with it.

Now we can add clock faces to the model. You could do this with cylinders,
but since the clock faces won’t have any depth we’ll use a flat circle. Press A

and add a Circle from the Mesh menu, resize it to have a diameter of 2.5, then
call it ClockFace. The circle is just an outline, and we need to fill it with a solid
face. Select the circle, go into edit mode, make sure all the vertices are selected,
and press f. Go back to object mode, and position the circle inside one of the
holes you’ve made, set back a little from the front.
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Make three additional copies of the ClockFace, put them in the other holes,
and then make all four ClockFaces children of the ClockTower. A rendered image
should now look something like this:
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6 Materials and Textures

Things are starting to look like a clock tower, but it’s all shades of pale grey,
which is not ideal. To fix this we need to add some more detail.

6.1 The Sky

Lets start with something that is simple to do. Go into the World properties
(the globe icon in the Properties panel) and check the box beside Blend Sky
in the World panel. Click on the rectangle under Horizon Color to bring up a
colour picker and choose a fairly pale blue (not too pale though). Do the same
for Zenith Color and set it to a lighter shade of the same blue. Note that when
choosing colours, a lot of people go for very strong colours. Often more muted
shades are easier on the eye. To see the effects of this you can either render an
image, or change the view from Solid to Rendered.

6.2 Materials

To add colours to the objects in a scene we need to define some materials. The
real clocktower is made of bluestone (the dark grey basalt) with Oamaru Stone
(the white limestone decoration), its roof is copper which has formed a green
patina, and we’ll make the ground a nice grassy green.

Select the MainTower and go into the Materials property pane (the circle
divided into quadrants). All the objects currently have a default material, which
is a fairly shiny light grey. At the top of the Materials pane is a list of materials
currently applied to the object – it is possible to have more than one, as they
they interact in different ways. Currently there is just the default material,
called Material

First, select the default material in the list and press the - button to the
right of it. This will remove the default material. Now click on New to add
a new material and call it Bluestone. Below the material list is a preview of
the material so you can see what it might look like. If you change the 3D
view shading model (to the right of the object/edit mode menu) to Material or
Rendered you can see the effects in the scene as well.

6.2.1 Your First Material

First we’ll change the material’s basic colour, which is the Diffuse panel. Click
on the coloured rectangle to bring up a colour picker, and make it dark grey.
Don’t got too dark – it is easy to take colours to the extremes – and you may
want to add just a faint tinge of blue.

The sphere preview shows quite a strong highlight, which makes the material
seem like plastic rather than stone. This is known as a specular reflection, and
you can see that in the Specular there are settings for Intensity (default of 0.5)
and Hardness (default of 50). The intensity is how bright the reflection is,
and the hardness is how sharp or blurry it is. For a stone surface we want to
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reduce them both, probably not to zero but maybe 0.2 for Intensity and 10 for
Hardness.

Now we have a Bluestone material we can re-use it for other elements. Select
the ClockTower, and you will be able to add the Bluestone material to that
element as well. Just select it from the drop-down below the materials list for
that object.

Next we might want to apply this material to the turrets. If you select the
Turret object, and change the material. Recall that we made the other turrets
children of this one – but they have independent materials at the moment.

Select the four turrets, making sure to select the primary Turret last – this
might be easier if you only show the turrets’ layer, or use a wireframe view.
Press control-l to link properties, and choose Materials

6.2.2 More Materials

The light coloured stone used for the trim is a type of sandstone from near
Oamaru. Make a new material for this type of stone. It should have similar
properties to Bluestone, but be a light cream colour. Apply this material to the
buttresses.
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Make separate materials for the clock faces, ground plane and the roof of
the tower. The clock face can look the same as, or similar to, the buttresses,
but we’ll be adding a texture to it soon, so it needs to be different. The roof
should be a pale green, and the ground could be a grassy green or an earthy
brown as you like.

6.3 Adding Texture

Materials provide a basic colour for an object, but often we want more detail.
The clock face, for example, could do with some numbers and hands. We
could model this with geometric objects, but unless we’re going to get up very
close then that’s probably too much work. Another approach is to use an
image to provide this detail. The following image can be found from https:

//pixabay.com/en/clock-old-clock-antique-clock-face-1605224/

Save this image with your .blend file, then select the ClockFace object. Go
into the Texture properties pane, which is the checkerboard beside the material
property pane. Add a new texture called ClockFace, change its preview to Both,
then in the Image panel choose Open and browse to find the clock face image.
If you change the preview to a cube, it should look something like this:

That looks pretty good, so let’s see how it renders. . .
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That’s not great, and the problem is how the texture is wrapped around the
object. There are quite a lot of options for this, but the one we need to change
is to switch the Coordinates in the Mapping panel from UV to Generated. A
rendered image should now look like this:
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